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Watch your email for APCUG 

workshops and  

other upcoming events. 

LACS 

A Computer and 

Technology 

 User Group 

LACS IS A MEMBER OF 

APCUG 

  An International 
  Association of Technology 

  and Computer User Groups                                    
  www.apcug2.org 

   www.facebook.com/APCUG 

   www.twitter.com/apcug 

Celebrate  

Christmas, Hanukkah, Kwanzaa, 

and the New Year 

THERE WILL BE NO GENERAL MEETING 

IN DECEMBER. 

 

Don’t forget to pay your 2024 LACS dues 

before or in January 2024. 

See pages 2, 8, and 19 for updates on the new dues-

paying system and for the amount due in 2023. 

We wish you a happy holiday season and urge you to 

let us know how we can help you enjoy your computer 

and other technical equipment more. The November 

Meeting Report on pages 2-3 of this issue should give 

you many ideas of better ways to use your devices. If 

you want a particular topic or a Special Interest Group 

(SIG), let us know. Also, please help us to increase our 

membership. Let’s make a New Year’s resolution to at-

tend our Zoom general meetings. Happy New Year! 

http://www.apcug2.org
http://www.facebook.com/APCUG
http://www.twitter.com/apcug
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WELCOME NEW AND  

RENEWING MEMBERS TO LACS  

WARNING: THE FULL ANNUAL DUES 

AMOUNT IS DUE IN JANUARY 2024  

FOR ALL MEMBERS. 

FROM YOUR PRESIDENT / EDITOR 

Gavin Faught, LACS Treasurer 

Members Renewed for 2024 (17) 

 

Loling Beckman, Contributor 

Janet Chesne 

Guy Clark 

Leah Clark 

Edie Ditmars 

Leonardo Israeli 

Helen Karagozian 

Howard Krevoy 

Larry McDavid 

Sheila Moncavage 

William Oppenheim 

Charlotte Sermple 

James Somerville 

Kim Stocksdale 

Annette Tossounian 

Paula Van Berkom  

George Wolkon, Contributor 

       Beginning in 2024,  all LACS mem-

bers’ annual dues will be payable in Janu-

ary. You may pay your 2024 dues in No-

vember or December, 2023 or in Janu-

ary,2024. Use the following chart to see 

the prorated amount you will owe for the 

remainder of 2023. When paying by Pay-

Pal, Zelle, or check, please note for what 

year and level you are paying.  

I have often used Google Lens on my Android 

phone to identify a flower or something I had 

photographed. Until I saw the article on page  

7, I didn’t know I could use it on my PC to ana-

lyze any image. Yes, we live and learn! 

    MEMBERSHIP LEVELS Select the month you are renewing or are joining LACS. 

Yearly Rate Monthly Rate Dec. Nov. Oct.

New/Renewal with Newsletter $40 $3.33 $3.33 $6.66 $10.00

New/Renewal with Electronic Newsletter $30 $2.50 $2.50 $5.00 $7.50

H

aHappy  
Hanukkah 

Merry 
Christmas 

Happy 
Kwanzaa 

Happy 
New Year 
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    Judy Taylour started by dis-

cussing many utilities she 

finds useful in her computer 

work. Here is a list of the apps 

and programs she spoke about in both the 

utilities and accessibility parts of the presenta-

tion, with a short comment on each. Members 

of LACS received the link to the meeting re-

cording so they can get the details on each 

one. There was much more information than 

what’s in this report. 

Most utilities have both free and paid ver-

sions. The approximate time into the record-

ing is noted to make it easier to find the ones 

you want to review.  

USEFUL UTILITIES 

Belarc Advisor reports on your computer 

system's hardware, software, patch and secu-

rity status, networking inventory, serial num-

bers, and more. 010:14  

TinyURL shortens lengthy URLs to make 

them easier to share and access. 0:12:18 

Bitwarden is an excellent open-source, cross

-platform password manager. 0:13:20 

CCleaner analyzes, fixes, tunes, and cleans 

your hard drive. 0:16:59 

Evernote helps you organize ideas, projects, 

and to-do lists. 0:18:27 

Edge Collections is a good way to collect 

notes for different projects together. 0:19:35 

Grammarly reviews spelling, grammar, punc-

tuation, clarity, and other mistakes, and to 

customize your style, tone, etc. 0:20:39 

iDrive is a cloud backup solution. 0:22:08 

Nextdoor is a social network for your neigh-

borhood to keep you informed about what’s 

going on in your area. 0:25:11 

NitroPDF Reader is a good alternative to 

Adobe Reader. 0:28:00 

Patch My PC updates all your software that 

is not updated by Microsoft Patches.  

0:29:27 

Hard Disk Sentinel monitors and analyzes 

SSDs and HDDs to ensure maximum safety 

of your data and warns about possible immi-

nent failure. 0:33:14 

PayPal is a safe way to pay for online shop-

ping because no one knows your credit card 

or bank account numbers. 0:35:46 

Venmo can be linked to your bank account 

for sending money to family and friends, and 

for making purchases. 0:37:34 

Recuva can restore deleted material from 

HDs, USB drives, and memory cards. 

0:44:03 

Revo Uninstaller uninstalls things left be-

hind by Windows’s built-in tool. 0:44:48 

Unchecky automatically unchecks all the 

checkboxes when you are installing a pro-

gram to prevent unwanted software from 

sneaking onto your hard drive if you forget 

to click on Custom Install. 0:46:06 

VLC Media Player plays every media for-

mat for viewing videos. 0:50:48 

Pay/Wallet Apps include many ways to pay 

for purchases and often to receive rebates. 

0:51:16 

ColorNote keeps all your Android notes, 

passwords, medications, and more encrypt-

ed and easily at hand, and syncs them with 

your computer. 0:53:37 

Everything locates files and folders by file 

name on your computer and monitors 

changes. 0:56:13 

WordCloud Generator generates word 

cloud graphics using the words you choose. 

0:56:57 

GENERAL MEETING REPORT 
November 14, 2023 

By Leah Clark, LACS President/Editor  

Topic: Useful Utilities & Accessibility 

Speaker: Judy Taylour, APCUG Regional X 

Advisor and Speakers Bureau. 
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Larry McDavid, an LACS member, spoke  

about Snagit, one of his favorite programs. 

He has found it to be a very effective screen-

capturing program. Its major advantages are 

that it will scroll to capture an entire article, 

and you can select any segment on a screen 

to copy. It will also capture video. You can 

edit what was captured. 1:02:32 

ACCESSIBILITY 

Judy then proceeded with the second part of 

her presentation on accessibility. She started 

with information on preventing problems by 

arranging the computer screen, chair, and 

desktop peripherals to align your body cor-

rectly when working. She discussed the im-

portance of using computer glasses and hav-

ing good lighting. Judy explored software, 

peripherals, and accessible and assistive 

technology to make your computer, phone, 

or tablet easier to use.  

Some functions have different names and 

locations in Windows 10 and 11. Judy lists 

some of the differences toward the end of 

the presentation. For many customized set-

tings, go to Settings > Ease of Access or Ac-

cessibility > then scroll down the list of op-

tions to find what you want.  

Document Accessibility  

In Word, go to Review > Check Accessibility 

> check “Keep accessibility checker running 

while I work.” Judy has found this to help 

make documents easier to read. 1:11:53 

Repetitive Strain Injury affects muscles, 

tendons, and nerves in your hands, wrists, 

arms, neck, and upper back. RSI can result 

from poor posture, repetitive motions, or us-

ing the wrong keyboard or mouse. 1:13:02 

Sticky Keys at > Keyboard > Sticky Keys 

lets a user push shortcut key combinations 

one key at a time. 1:16:11 

Monitor Touch Keyboard at Settings > 

Ease of Access or Accessibility > Keyboard 

> On-Screen Keyboard. 1:16:31 

Key Warning Sound at > Keyboard > Tog-

gle Keys to play a sound when typing in all 

caps or when the Num Lock key is pushed. 

1:17:10 

Mouse Pointer at > Keyboard > Mouse 

Pointer to change the pointer size and color, 

to change the speed of the pointer or cursor, 

to single click to open an item, or to choose 

how many lines to scroll at a time. 1:18:16 

High Contrast allows you to have a black 

background, enlarge the text, etc. 1:21:53 

Desktop Icons: Right-click on your desktop 

> View > Select the size and position of desk-

top icons. 1:23:35 

Taskbar Icons: Go to Settings > System > 

Display > to change the size of icons and 

text. 1:23:56 

Magnifier: Go to Settings > Ease of Access 

or Accessibility > Magnifier >Turn on. 1:24:46 

View Word Document: In a Word document, 

go to View > Zoom > Page Width to make a 

document easier to see and edit. 1:27:07 

Narrator: go to > Narrator for a screen read-

er that describes what’s on your screen; it is 

controlled by keyboard, touch, and mouse. 

There are over 30 options to customize! You 

can also talk to your computer. 1:28:44 

Closed Captions: Go to Closed Captions in 

Ease of Access to customize the size and 

color the way you like. 1:31:11 

Mono Audio: If hearing is better in one of 

your ears than the other, you can turn the 

sound up differently for each one. 1:33:53 

iPhone Accessibility features include vision, 

hearing, and physical and motor skills. Go to 

Settings > Control Center > Customize Con-

trols > Accessibility or triple-click the Home 

button. Judy showed a lot of helpful options. 

iPhone SOS can make emergency calls even 

without cellular or Wi-Fi coverage. There is a 

fall-detection function. 1:34:52 
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• Establishing credibility 

• Creating a need for follow-on paid com-

ponents 

• Bait and switch tactics 

• Outright lies 

Fun 

Believe it or not, some people actually enjoy 

computers. In fact, there are those who 

would work with computers even if they 

weren't getting paid. These are folks for 

whom computers are a hobby, a career, or 

both.
1
 

Programmers who just love what they do are 

one source of free software. While it may be 

more than that, one motivation is the ability 

to produce something people find useful be-

cause they can and want to. They may not 

want to be burdened with the additional re-

sponsibility or commitment that getting paid 

for their work might imply. 

They just want to have fun. 

Altruism 

There are also those who produce free soft-

ware to give back to their communities or to 

the world. They see what they do as a way 

to make the world a better place. Perhaps 

they get satisfaction from offering software 

to folks who can't afford equivalent commer-

cial software. 

Some folks donate money; others donate 

time; those with skills often give back by uti-

lizing those skills in various ways. 

There are many ways programmers can of-

fer their skills, but with a little entrepreneurial 

spirit, it's not uncommon for free software to 

result. 

Agenda 

Some free software is created by individuals 

or organizations to promote an agenda of 

some sort. 

For example, consider the old "https every 

 

 

Android Phones: Go to the Google Play 

store > Accessibility Suite. 1:39:22 

RSI Assistive Mouse is a large trackball 

mouse for those who lack fine motor skills. 

There are other ergonomic mice available for 

various needs. 1:40:39 

Low-Vision Keyboard: Judy showed key-

boards with yellow stickers with black letters 

on the keys. She also showed various ergo-

nomic keyboards. 1:43:06 

Dragon Home is a Magnifier/Reader for low-

vision users. 1:45:56 

Hearing Aids and Bluetooth help you stay 

connected to audio devices. 1:46:26 

Opticon Hearing Aid Solutions are built on 

BrainHearing™ technology. 1:47:08 

Judy has links to some of her sources at the 

end of her presentation. ❖ 

WHY DO PEOPLE CREATE FREE 

SOFTWARE? 
Free isn't always free, but sometimes it's 

close enough. 

By Leo A. Notenboom 

The Best of Ask Leo! 

leo@askleo.com 

    Free software exists for rea-

sons ranging from pure altruism to 

pure deceit. 

What prompts an individual or organization 

to create and offer software for free? Occa-

sionally, there's a hidden agenda, but sur-

prisingly often, there isn't. 

Naturally, I can only speculate, but I can 

think of several broad reasons that individu-

als or organizations creating free software 

might have for their generosity. 

• Fun 

• Altruism 

• Promoting an agenda 

• Making money in some related way 

https://mail.yahoo.com/d/search/keyword=leo/messages/ACP5hhVlgTpEY_Omawmg2DAlzso#al_footnote_1
https://askleo.com/about-leo?awt_a=7qbL&awt_l=84pLT&awt_m=3doJ9nM3k0Cj5bL
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where" browser add-on, which promotes us-

ing https connections wherever possible. 

This software is freely available to encourage 

people to use HTTPS secure connections, 

but also to raise awareness of privacy issues 

and encourage sites to support HTTPS as a 

secure connection mechanism.
2
 

Money 

It may seem contradictory, but some people 

offer free software, expecting it to make mon-

ey. The idea is that software spreads far and 

wide by being given away. Once installed, the 

software reminds or encourages the user to 

donate to the software creator. The reminders 

can range from the polite to the obnoxious, 

but the bottom line is that enough people may 

donate to make the effort worthwhile. 

Most donationware, as it's sometimes called, 

rarely recovers the cost of creation, but it's 

one way to offset that expense and reward 

the creator, particularly for especially useful 

software. 

Another approach that is particularly common 

on mobile platforms is advertising. The pro-

gram — typically a game — is completely 

free, but you watch advertisements that gen-

erate income for the creator. 

Yet another approach is branding or brand-
building. Services like Outlook.com, Gmail, 
and others are free, but they act as a hook 
into their respective software ecosystems. 

Credibility 

Some free software exists to give the creator 

credibility for other commercial efforts. 

Organizations use this technique more often 

than individuals. By producing a good free 

utility, the company's other efforts benefit. In-

dividuals purchasing other software are more 

likely to look to that company if they've had a 

good experience with the free product. 

"Free for non-commercial use" is another ex-

ample. Many vendors make software availa-

ble for individuals to use at no charge, hoping 

that the reputation they garner will justify a 

purchase from the corporate environment. 

There's an old saying, "Give them razors, sell 

them blades." Razors, while more expensive, 

are typically a one-time cost. Blades, howev-

er, must be replaced periodically for as long 

as you own that razor. It doesn't take many 

blade refills to recoup the expense of the ra-

zor that cemented the relationship with a cus-

tomer for a much longer term. 

The same is true for software. I can think of 

two common scenarios: 

1. Give the software away for free and sell 

support. 

2. Give the base software away for free and 

sell add-ons for additional functionality. 

For example, I use a shopping-cart package 

that is totally free and quite useful just as it is. 

However, some of the additional functionality 

I want is provided by paid add-ons. So far, 

my "free" software has cost me a couple hun-

dred dollars. I'm not complaining at all — the 

base software lets me see what I was getting 

into and made me feel better about paying for 

the additions. 

Bait 

And then there's the dark side: free software 

used as bait. 

Unfortunately, we often see this in the world 

of malware, but it's true in other venues as 

well. It works like this: 

A company hypes a free solution. 

That free solution, which does exist and is 

indeed free, is also difficult to find. 

Instead, the companies steer you to a 

free trial, which is not the same. After the trial 

period is over, payment is required. 

It's quite legitimate to use a free product to 

advertise the existence of a more fully-

featured commercial product. It's something 

else to hype a free product as a lure to trick 

your prospects into downloading the free trial, 

which is ultimately not free. 

 

 

https://mail.yahoo.com/d/search/keyword=leo/messages/ACP5hhVlgTpEY_Omawmg2DAlzso#al_footnote_2
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Lies 

The worst case of bait and switch is the Free 

Scan scam. You think the software is free, but 

it's not, and it never was. 

This scenario is all too common. 

You see an online ad (usually with many ex-

clamation marks) for a "free scan" to help you 

fix some problem. 

The scan, which is indeed completely free, re-

ports errors. 

Sometimes those errors are legitimate; some-

times they're legitimate but entirely blown out 

of proportion to scare you; and sometimes 

they're out-and-out lies. 

If you want to fix the errors, it costs money. 

Some "free downloads" are a variation on this 

theme. The download is indeed free, but you 

still need to pay if you actually want 

to use what you downloaded. 

Footnotes  

1: I've often referred to my own career in this 

light: computers and technology are both my 

career and my hobby. 

2: I'd say the agenda has succeeded since 

most websites these days are https. ❖ 

WHAT YOU NEED TO KNOW ABOUT 

GOOGLE LENS  
This is Part 1 of a two-part article. 

By Stuart Berg, Daves Computer Tips  

dave@davescomputertips.com 

    Google Lens is not well known, but it should 

be. It enables you to search the Internet to an-

alyze a specific image you choose. Why? I’m 

glad you asked. It’s because you might want 

to find a similar image, identify something in 

an image, find the source of an image, find 

where the photo was taken, find information 

about the image, translate text, convert an im-

age to text, answer a homework question, and 

find where to buy something in an image 

Using your phone's camera, the Lens uses artifi- 

 

cial intelligence to find text and objects from 

within images and even from a live view. It then 

enables you to find what the internet can tell 

you related to that image. Us-

ing Google Lens for the flag 

shown here will  recognize it as 

the Flag of Spain.  

Or maybe you see the dog 

photo shown below and would 

like to know the breed. Using 

Google Lens will immediately 

tell you that the dog is a Cock-

er Spaniel. 

Google Lens can be used from 

any browser by just opening Google search, as 

shown below at Google.com. 

Note the camera icon. Clicking on it will open 

Google Lens in your browser. It offers three 

ways to use Lens: drag an image, upload an im-

age file, or paste an image link, as shown in the 

image below. 

 

 

 

 

 

 

 

 

 

Stuart Berg has played with, worked with, and built 

computers for over 55 years. He led a life full of engi-

neering and financial application development and 

management. Now retired, he enjoys focusing on help-

ing people solve their computer problems. ❖ 

https://mail.yahoo.com/d/search/keyword=leo/messages/ACP5hhVlgTpEY_Omawmg2DAlzso#al_footref_1
https://mail.yahoo.com/d/search/keyword=leo/messages/ACP5hhVlgTpEY_Omawmg2DAlzso#al_footref_2
https://davescomputertips.com/author/stuart-berg/
https://davescomputertips.com/wp-content/uploads/2023/01/4-Google-Lens.png
https://davescomputertips.com/wp-content/uploads/2023/01/google-lens-flag-for-example.jpeg
https://davescomputertips.com/wp-content/uploads/2023/01/google-lens-dog-for-example.jpg
https://davescomputertips.com/wp-content/uploads/2023/01/3-Search-Using-Google-Lens.png
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        FIX YOUR PC FOR FREE? 

LACS member and presenter, 

Jim McKnight, has an open  

offer to LACS members to diagnose, repair, 

disinfect, or upgrade members' PC’s for free.   

There are certain limitations to Jim’s offer, so 

see the details by clicking the “Fix my PC for 

Free?” link at www.jimopi.net. 

Non-members can wisely invest in a one-

year new regular LACS membership 

($40.00), and Jim will fix your PC problem, 

too. Contact Jim for specific considerations. 

LACS INFORMATION    

HOW TO CHANGE YOUR CONTACT 

 INFORMATION 

Go to www.lacspc.org. Click on Member 

Forms in the bar under the picture. Under 
Membership Update, select Click Here to 
select either the DOC or PDF form. Fill it out, 
and email it with your changes to  

 

or snail-mail it to 

Los Angeles Computer Society 
11664 National Blvd. #343  

Los Angeles, CA 90064-3802. 

ATTENDING A ZOOM MEETING 

LACS members who are on our PC email list 

will receive a link, meeting ID, Passcode, 

and instructions to attend the LACS general 

meetings a couple of days before the meet-

ing. Please let Leah Clark know by the 

morning of the meeting if you don't have 

it or have any problem.  

You can put an icon to the link on your 

desktop so it's handy at meeting time. 

1. Right-click a blank spot on your desktop. 

2. Select New from the drop-down menu. 

3. Select Shortcut. 

4. Type or copy and paste the link in the box 

that says "Type the location of the item." 

5. Click Next. 

6. Type a name for the shortcut. 

PAY DUES BY PAYPAL OR ZELLE 

To pay by PayPal, go to this link: 

www.paypal.com/paypalme/00001024 

and then click on Send. You'll be asked to 

log in to your PayPal account or sign up 

for an account so that PayPal will know 

where to get the money to send. Follow 

the prompts. Once you have entered your 

dues amount, click on Add a note. Tell us 

of any updated information: physical ad-

dress, email address, phone number, and 

what type of dues you are paying: regular, 

electronic User Friendly, etc. or if you don't 

want your contact information published in 

the roster.  

To pay by Zelle, log into your bank with 

your username and password. 

Select Transfer Money > Send Money 

with Zelle. Follow the instructions. The 

name of the recipient is Los Angeles 

Computer Society. Select Send by 

email. The email address is:  

lacomputersociety@gmail.com. The 

wording may be a little different on your 

bank’s site. Email questions to Gavin at 

. 

HOW TO JOIN LACS’S MAIL LIST 

LACS now has one active general list: 

PC@LACS.Groups.IO. Use this email ad-

dress to ask questions, to offer any com-

ments or suggestions, and to conduct offi-

cial LACS business.  

New LACS members should receive an in-

vitation to join our list with two weeks to ac-

cept. LACS members who want to join the 

list should send an email to 

LACS+subscribe@Groups.IO from the 

email address they want to use with their 

name and phone number. Stephanie, our 

Groups.IO Coordinator, will check your 

membership and add you to the PC list. 

Contact her at 

. 

http://www.jimopi.net
http://www.lacspc.org
http://www.paypal.com/paypalme/00001024
mailto:PC@LACS.Groups.IO
mailto:LACS+subscribe@Groups.IO
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UPCOMING MEETINGS/EVENTS 

 December 2: Holiday Party 

January  9, 2024: TBA 

Check your email and User Friendly for        

 updates to this schedule. 

 LACS CALENDAR 

LACS Board Meeting, December 4 

Time: 7:00 P.M. (Open from 6:30 P.M.) 

Place: Wherever you are via Zoom 

Please log in early so we can start on time. 

USER FRIENDLY BACK ISSUES  

AND INDEXES 

To see back issues of User Friendly, go 

to http://www.lacspc.org/category/user-

friendly/.  

For indexes to past issues, go to  

https://www.lacspc.org/category/uf-index/ 

To find a specific article or topic, use the 

search box on the top right.  

ZOOM MEETINGS 

Members on our PC email list will receive, 

via email, an invitation to join LACS Zoom 

general meetings. Click on the URL in the 

invitation before the meeting  and follow 

the prompts. Contact Leah Clark at   

if you have any ques-

tions or if you don't receive the link by the 

morning of the meeting day.  

VISIT OTHER APCUG COMPUTER USER 

GROUPS AND SEE THEIR NEWSLETTERS 

Many APCUG groups allow members of other 

groups to attend their meetings. LACS heartedly 

welcomes visitors from other user groups, and 

we are welcome to join other groups’ meetings. 

Go to www.APCUG2.org . Click on Member 

Benefits, then on Groups Sharing Meetings or 

on Newsletters Online. A list of groups sharing 

meetings is arranged by time zones. 

ZOOM RECORDINGS    

LACS members will receive links to 

the recordings of Zoom meetings 

via email.   

HYPERLINKS 

Underlined text (blue in the color edi-

tions) in User Friendly usually means 

it's a hyperlink to a website. Copy and 

paste it into your browser’s search or 

into your address bar. Or click on the 

link on the online version to see the 

referenced place. 

December 4: LACS Board Meeting 

December 7: Hanukkah Begins 

December 7:  Pearl Harbor Day 

December 25:  Christmas 

December 26: Kwanzaa 

December 31: New Year’s Eve          

December 

http://www.lacspc.org/category/user-friendly/
http://www.lacspc.org/category/user-friendly/
http://www.lacspc.org/category/uf-index/
http://www.APCUG2.org
http://www.APCUG2.org
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MEMBERS HELPING MEMBERS 

LACS members volunteer to help other members solve hardware and software problems by 

telephone or during the hours listed below. Select the topic from the list and then contact a 

person whose number is listed next to it.  

Find a helper's email address and phone number on your roster. If you don't have your 

roster, call 424-261-6251. Only members in good standing may receive a roster. We hope 

you find this LACS free service useful.  

If you are experienced using a particular program or hardware, please volunteer to be 

a consultant. You don't have to be an expert. To volunteer for this list or to make 

corrections, please email Leah Clark at or call her at 424-261-6251. 

Adobe Creative Suite: PDF,  

   InDesign, Photoshop, etc. - 10 

Android Smartphones - 8 

Apple devices - 11 

Anti Malware and Backup - 7, 8 

Dragon Naturally Speaking - 3 

Genealogy - 8 

Groups.IO - 8  

  Hardware - 7 

Lotus Word Pro, Approach - 7 

Mozilla Firefox  - 7 

MS Excel -  8, 11, 12 

MS Word -  1, 3, 8, 12 

MS Outlook - 1, 8, 10 

MS PowerPoint - 8, 11 

MS Publisher - 2 

      PDF 24 - 8 

Photoshop - 10 

Quicken - 8, 12 

Thunderbird - 7 

Utilities - 7, 8 

Visual Basic - 5 

Websites - 5 

Windows  - 7, 8 

WordPerfect - 8 

Zoom - 2, 9 

                                                        Note: Times are Pacific Times 

Number Name    From   To

1 Beckman, Loling 10:00 AM 6:00 PM

2 Clark, Leah 7:00 AM 5:00 PM

3 Hershman, Irv 11:00 AM 11:00 PM

5 Ialongo, Gilbert 9:00 AM 5:00 PM

7 McKnight, Jim 8:00 AM 7:00 PM

8 Nordlinger, Stephanie 9:00 AM 5:00 PM

9 Presky, Mark Any          Any 

10 Rozek, E. J. Noon 8:00 PM

11 Van Berkom, Paula 9:00 AM 5:00 PM

12 Wilder, Joan 9:00 AM 9:00 PM

                         Preferred Time for Phone Calls
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OFFICERS, DIRECTORS AND LEADERS 

   Mailing Address:  11664 National Blvd., #343, Los Angeles, CA 90064-3802     

      Website:        www.lacspc.org   

            Contact the President/Editor at  424-261-6251. Follow the prompts. This is a                              

                                                                                                                                                                                                                                Google Voice number.                                 

Please use your roster for email addresses and phone numbers to contact any  

officer, board member or other member, or you may leave a message at the above 

number. If you don't have your roster, please contact Leah Clark at 

and she will mail you a copy. Only LACS members may receive a roster. 

    TITLE                  NAME TERM 

President Leah Clark 2024 

Vice President Stephanie Nordlinger 2024 

Secretary Marcia Jacobs 2024 

Treasurer Gavin Faught 2024 

Director Loling Beckman 2025 

Director Howard Krivoy 2025 

Director Mark Presky 2025 

Director Irv Hershman 2024 

Director E. J. Rozek 2024 

Director Annette Tossounian 2024 

Director Paula Van Berkom 2024 

Immediate Past President Stanley Johnson  

APCUG Representative Leah Clark  

Corporate Counsel Stephanie Nordlinger   

Database Manager Loling Beckman   

Groups.IO Email Lists Stephanie Nordlinger   

Newsletter Editor Leah Clark   

Program Chair Stephanie Nordlinger   

Publicity – Press Mark Presky   

Publicity – Online Media Open   

    Quick Consultants Leah Clark   

    Webmaster Paula Van Berkom   

       

       

http://www.lacspc.org
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BESCUSTOMIZING YOUR  

WINDOWS 11 DESKTOP 
Tom Burt’s Windows 11 Desktop 

by Tom Burt, Vice President 

Sun City Summerlin Computer 

Club   https://www.scscc.club   

Tomburt89134(at)cox.net 

 
Introduction 

    Windows 11 usage       

    steadily increases as      

     more users upgrade         

     from Windows 10 or         

     buy a new PC with 

Windows 11 pre-installed. This article will of-

fer a few configuration options for making the 

Windows 11 desktop more to your liking. We’ll 

touch on various settings, mainly in the Per-

sonalization area. 

Choosing a Theme 

    The default theme is Windows Light. PCs 

from commercial vendors like HP, Lenovo, or 

Dell may have customized this. Click the Set-

tings gear icon on the Start menu and 

choose Personalization > Themes. The 

Themes settings screen will display (see 

screenshot below.) 

It shows your current theme along with any 

customizations. Note that a Theme includes 

colors, images, sounds, and mouse cursor 

settings. When you have adjusted all the re-

lated settings, you can Save those settings 

as a named custom Theme. 

Themes Settings 

Windows 11 offers six default Themes. Hover 

the mouse over each to see the name and 

behavior. Some Themes rotate between sev-

eral background images. I decided to keep 

the default “Windows Light” theme and then 

to customize it. 

Choosing Desktop Icons 

On the main Themes settings, under Related 

settings, is a link for Desktop icon settings. 

Click this to bring up the dialog below. 

You can 

click the 

check-

boxes to 

specify 

which 

icons you 

want to 

appear 

on your 

desktop. 

The central panel 

shows how each 

icon will appear. 

You can select an 

icon and click the 

“Change Icon” 

button to open an 

icon chooser dia-

log. In addition, 

you can click the 

https://www.scscc.club
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Restore Default button to revert an icon to the 

Windows default. 

Unchecking the “Allow themes to change 

desktop icons” checkbox will retain your desk-

top icon settings if you decide to change to a 

different theme. 

Choosing a Desktop Background 

My next Desktop customization was to select 

a different background wallpaper. I liked the 

blue bloom but preferred it on the dark back-

ground used in the “Windows Dark” Theme. 

So I Googled for the location of the images for 

Windows 11 themes and found the blue bloom 

on a dark background at 

C:\Windows\Web\Wallpaper\Windows, named 

“img19.jpg”. 

I copied this image to my Photos\Saved Pic-

tures folder and renamed it “DarkBloom.jpg.” I 

then went to Settings > Personalization > 

Background, and set the dropdown to 

“Picture,” and clicked the “Browse photos” but-

ton. Next, I browsed to Pictures\Saved Pic-

tures and selected my DarkBloom.jpg image. 

That set my background to the desired Dark 

Bloom. 

You can set the Desktop background to a solid 

color, a single image, or a rotating slide show. 

Knock yourself out! 

Choosing Colors 

My next Desktop customization was to change 

some of the color settings. I went to Settings 

> Personalization > Colors. This opened the 

screen partially shown in the next column. 

I left the Mode (Light) and “Transparency ef-

fects” settings On as they were. I set the Ac-

cent color mode to Manual, and then I chose a 

medium blue from the palette. I could have 

created a custom color if I didn’t like any of the 

palette’s colors. 

Next, I scrolled further down until I saw a slider 

button for “Show accent color on title bars and 

windows borders.” I clicked to turn this On. 

See screen in next column. 

Colors Settings 

More Colors Settings 

Configuring the Taskbar 

My next Desktop customization was to set up 

the Taskbar. I visited Settings > Personaliza-

tion > Taskbar to bring up the settings screen.  

See Figure 1 on page 14. 

Taskbar Settings 

I turned on the sliders for Search and “Task 

view” and turned off Widgets and Chat. Under 

the Taskbar corner icons (Pen menu, Touch 

keyboard, and Virtual touchpad), I left them all 

Off.  

I next clicked the down chevron to open the 

“Taskbar corner overflow” settings. The Taskbar 

corner was formerly known as the Notification 

area and the Windows Tray. Next, I turned on 

the Microsoft OneDrive and Windows Update 

Status icons to make them visible. The others 

appear in the overflow popup. See Figure 2 on 

page 14. 

 
                    

file:///C:/Windows/Web/Wallpaper/Windows
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     Figure 1 

      Figure 2 
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Taskbar Corner Overflow Settings 

 
Lastly, I clicked the down chevron to open the 

Taskbar Behaviors settings. See Figure 3 

below.  

Taskbar Behaviors Settings 

For Taskbar alignment, I selected Left from 

the dropdown. The default is Center. I left the 

“Automatically hide the taskbar” unchecked, 

and I left the “Show badges (unread messag-

es counter) on taskbar apps” checked.  

                                                                                                                                                                                 

Adding Shortcuts to Programs 

Use the File Explorer to browse the pro-

gram’s .exe file (usually in Program Files or 

Program Files (x86). Left-click to select 

the .exe file and press Shift + F10 to bring 

up a context menu. Hover the Mouse over 

the “Send to” menu option and wait for a 

secondary menu to appear. Then click 

“Desktop (create shortcut).” Finally, rename 

the new Desktop shortcut to suit. ❖ 

 

Figure 3 

HANDS ON WITH MICROSOFT  

COPILOT IN WINDOWS 11 
Your Latest AI Assistant 

By Judy Taylour, October 26, 2023 

www.apcug2.org 

The first generative AI built into an operating 

system is here. We take Microsoft Copilot 

out for a spin. A colorful new icon will soon 

appear on your Windows 11 taskbar, leading 

to a new era in desktop computing in the  

form of Microsoft Copilot. This AI chat side-

bar powered by OpenAI, Bing, and Microsoft 

technologies can change computer settings 

or open apps. It can not only generate text 

and images, but it can also create either 

based on the other. Learn more about  

Copilot in this PCMag article. 

Hands On With Microsoft Copilot in Windows 

11, Your Latest AI Assistant | PCMag ❖ 

https://apcug2.org/author/judy_tayl0ur/
http://www.apcug2.org
https://www.pcmag.com/news/hands-on-with-microsoft-copilot-in-windows-11-your-latest-ai-assistant?utm_source=email&utm_campaign=windows11&zdee=gAAAAABjNL8QJ6N7RLI_1J88e8J0LPuv5wkxqVhbmSIZrgL-0TnomfPH19-kAXjpJFHoiG1XvtyrVdXZCoBHK2iqrJgmIRkWQNf2Z7FkshSsEO9SDTuC
https://www.pcmag.com/news/hands-on-with-microsoft-copilot-in-windows-11-your-latest-ai-assistant?utm_source=email&utm_campaign=windows11&zdee=gAAAAABjNL8QJ6N7RLI_1J88e8J0LPuv5wkxqVhbmSIZrgL-0TnomfPH19-kAXjpJFHoiG1XvtyrVdXZCoBHK2iqrJgmIRkWQNf2Z7FkshSsEO9SDTuC
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DEVICE COMMUNICATIONS — 

BLUETOOTH 
BY Phil Sorrentino   

Sarasota Technology User Group 

www.thestug.org 

 

    Here's a simplified introduction 

to how computer devices communicate. 

When two devices need to 'talk' to each oth-

er, they  must first 

agree on the method 

of communication. 

Will they use wires or 

wireless signals? If 

wires, how many will 

be needed? Once 

these physical aspects are agreed upon, they 

must decide how much data will be sent at a 

time. For instance, serial ports send data bit 

by bit, while parallel ports send multiple bits 

simultaneously.  

These devices must speak the same lan-

guage, known as a protocol, to communicate 

effectively. One example of this is Bluetooth, 

a wireless standard that covers both the 

physical and protocol levels. Before any com-

munication can happen between two Blue-

tooth devices, they must be paired using a 

shared code or Passkey.  

Here's a simple description of Bluetooth pair-

ing: Device A looks for other Bluetooth devic-

es nearby. It finds Device B and prompts you 

to enter a Passkey, which is done automati-

cally when you select the device to pair. De-

vice A sends the Passkey to Device B, which 

sends it back to A. At this point, the devices 

are paired and ready to exchange data.  

To fully use Bluetooth, devices must be com-

patible with Bluetooth profiles and additional 

protocols that guide how Bluetooth-based 

wireless communication happens. Various 

profiles are designed for different purposes, 

including multimedia audio streaming (A2DP), 

control of audio/video equipment (AVRCP), 

sending images (BIP), sending print jobs 

(BPP), establishing connections (GAP), trans-

mitting medical data (HDP), supporting devic-

es like mice and keyboards (HID), and ex-

changing messages, often for hands-free au-

tomotive use (MAP). 

 As Bluetooth usage expands, we rely on the 

profiles implemented in our devices. With all 

the devices you own or plan to get, you're 

likely to encounter Bluetooth. Some common 

Bluetooth applications include:  

• Wireless control between a mobile phone 

and a hands-free headset  

• Wireless communications between PCs 

and their peripherals like mice and key-

boards  

• Replacing traditional wired serial commu-

nications in devices like GPS receivers 

and medical equipment  

• Communication between game consoles 

and their controllers  

• Baby monitor systems  

• Garage door openers 

• Health sensor devices  

If a Bluetooth device is to communicate with 

another device, it must be compatible with a 

subset of the profiles available. There are 

many profiles available. Some of the Profiles 

currently defined and in use are as follows:  

Advanced Audio Distribution Profile 

(A2DP)  

This profile defines how multimedia audio can 

be streamed from one device to another over 

a Bluetooth connection. This profile is de-

signed to transfer an audio stream of up to 2 

channel stereo, either to or from a Bluetooth 

host. For example, music can be streamed 

from a mobile phone to a wireless headset, a 

hearing aid, or from a laptop to a wireless 

headset. Also, voice can be streamed from a 

http://www.thestug.org
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  microphone to a recorder on a PC.  

Audio/Video Remote Control Profile 

(AVRCP)  

This profile is designed to provide a standard 

interface to control TVs, stereo equipment, 

etc., to allow a single remote-control device to 

manage all of the equipment to which a user 

has access. It is commonly used in car navi-

gation systems to control streaming audio.  

Basic Imaging Profile (BIP)  

This profile is designed for sending images 

between devices, and it includes the ability to 

resize and convert images to make them suit-

able for the receiving device.  

Basic Printing Profile (BPP)  

This profile allows devices to send text, 

emails, and other items to a printer.  

Generic Access Profile (GAP)  

This profile provides the basis for all other pro-

files and defines how two Bluetooth devices 

discover and establish a connection with each 

other.  

Health Device Profile (HDP)  

This profile is designed to facilitate transmis-

sion and reception of Medical Device data.  

Human Interface Device Profile (HID)  

This profile provides support for devices such 

as mice, keyboards, and joysticks, as well as 

sometimes providing support for simple but-

tons and indicators on some devices.  

Message Access Profile (MAP)  

This profile allows the exchange of messages 

between devices and is mostly used for hands

-free automotive use. 

Some of today’s more common applications of 

Bluetooth are:  

• Wireless control of and communications 

between a mobile phone and a hands-free 

headset. Wireless communications with 

PC input and Output devices, the most 

common being the mouse and keyboard. 

• Replacement of traditional wired serial 

communications used in test equipment, 

GPS receivers, medical equipment, bar 

code scanners, and traffic control devices 

• Between game consoles such as Ninten-

do’s Wii, Sony’s PlayStation, and their 

respective controllers.  

• Between video camera and remote moni-

tor in Baby Monitor Systems. 

• Between a garage door opener motor 

and a remote garage door opener  

controller. 

• Between a health sensor medical device 

and mobile phone or dedicated telehealth 

devices.  

There are many reasons for computer devic-

es to communicate with each other, going 

beyond the typical internet connection. ❖ 

APPLE INTRODUCES NEW  

FEATURES FOR COGNITIVE  

ACCESSIBILITY 
Along with live speech, personal voice, 

and Point and Speak in Magnifier 

By Judy Taylour, www.apcug2.org 

    Assistive Access includes a customized 

experience for Phone and FaceTime, which 

have been combined into a single Calls app, 

as well as Messages, Camera, Photos, and 

Music. The feature offers a distinct interface 

with high-contrast buttons, large text labels, 

as well as tools to help trusted supporters 

tailor the experience for the individual they 

support. For example, for users who prefer 

communicating visually, Messages includes 

an emoji-only keyboard and the option to 

record a video message to share with loved 

ones. Users and trusted supporters can also 

choose between a more visual, grid-based 

layout for their Home Screen and apps, or a 

row-based layout for users who prefer text. 

Read more at Apple previews Live Speech, 

Personal Voice, and more new accessibility 

features – Apple. 

https://apcug2.org/author/judy_tayl0ur/
http://www.apcug2.org
https://www.apple.com/newsroom/2023/05/apple-previews-live-speech-personal-voice-and-more-new-accessibility-features/
https://www.apple.com/newsroom/2023/05/apple-previews-live-speech-personal-voice-and-more-new-accessibility-features/
https://www.apple.com/newsroom/2023/05/apple-previews-live-speech-personal-voice-and-more-new-accessibility-features/
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NOTICE 
The columns, reviews and other expressions of 

opinion in User Friendly are the opinions of the 

writers and not necessarily those of the Los An-

geles Computer Society. LACS became a Califor-

nia non-profit corporation on July 17, 1991. Its 

predecessor was the UCLA PC Users Group. 

COPYRIGHT © 2023 
by the Los Angeles Computer Society, an all-
volunteer, tax-exempt IRC Section 501(c)(3)]  non-
profit California corporation. All rights reserved. User 
Friendly is published monthly. Subscriptions are in-
cluded in membership dues. Reproduction of any 
material here by any means is expressly prohibited 
without written permission, except that other non-
profit User Groups may reprint LACS articles in sub-
stantially unaltered form if credit is given to the au-
thor and this publication and an e-mail is sent to us 
via our website, www.lacspc.org, reporting the re-
print information (user group and the name and date 
of the publication). Product and company names are 
trademarks of their respective owners.  

SPECIAL OFFERS 

Go to the APCUG website at https://

apcug2.org/discounts-special-offers-for-user-

groups/ for discounts and special offers for 

Members of User Groups. Avast Anti-virus 

and Acronis True Image, and several book, 

media and training sites offer discounts in-

cluding the two mentioned below. 

• Members can save at the  

Pearson Technology websites:  

InformIT, Cisco Press, Pearson IT Certifi-

cation, Que Publishing, Adobe Press, 

and Peachpit Press.  

Informit.com/user_groups/index.aspx 

Code for print books: ITCOMMUNITY. 

Code for eBooks: DIGITALCOMMUNITY 

• See books on digital imaging and photog-

raphy, gaming, animation, film and video, 

post-production, audio, music technolo-

gy, broadcast and theatre at Routledge | 

Focal Press today! They offer discounts 

to User Group members. 

            LAUGHING OUT LOUD 

 

                 TECHBOOMERS.COM 

For learning how to use internet-based web-

sites and applications for free. 

• https://TechBoomers.com 

• https://www.youtube.com/watch?v=O2-

bwYIYu1I 

FOR MANY HELPFUL TIPS AND TRICKS 

Go to https://www.apcug2.org for all aspects 

of computing and operating systems.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From The Sarasota Technology Group 

https://apcug2.org/discounts-special-offers-for-user-groups/
https://apcug2.org/discounts-special-offers-for-user-groups/
https://apcug2.org/discounts-special-offers-for-user-groups/
Informit.com/user_groups/index.aspx
https://www.routledge.com/focalpress?utm_source=shared_link&utm_medium=post&utm_campaign=160701200
https://www.routledge.com/focalpress?utm_source=shared_link&utm_medium=post&utm_campaign=160701200
Https://TechBoomers.com
Https://TechBoomers.com
https://www.youtube.com/watch?v=O2-bwYIYu1I
https://www.youtube.com/watch?v=O2-bwYIYu1I
https://www.apcug2.org
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Annual Membership Dues: 

Regular New and Renewal,  

     Printed   Newsletter               $ 40 

     Electronic Newsletter         30 

Family-Associate                                           12 

Students                                                                                           18 

Contributor                                                                                  50 

Supporter                                                       75 

Benefactor                                                                        100 

Gift Membership                                                           20  

A subscription to User Friendly 

is included with membership. 

Associate members live in 

the same household or work at 

the same address as a regular 

member; they do not receive 

their own subscriptions to User 

Friendly, but may read it on 

the LACS website. Students 

must prove full-time status. A 

member may give a 1-year, 1-

time gift to a non-member. 

Monthly general meetings 

are via Zoom. In-person or 

hybrid meetings may take 

place in the future. 

Members also enjoy these 

special benefits: 
     —  Monthly Newsletter  

User Friendly. We publish your 

article submissions or free 

classified ads to buy or sell   your 

computer items. 

    —  Get FREE help by phone 

or email (See your roster) from 

knowledgeable members who 

are Quick Consultants listed in 

User Friendly. 

    —  Get help by email by  

using our group email list. Send 

your questions to 

PC@LACS.Groups.IO 

            —  Receive important news 

and announcements via User 

Friendly and LACS’s email list. 

   —    Free APCUG (International 

Association of Technology and 

Computer User Groups) Webi-

nars, virtual conferences, pro-

grams, and technical infor-

mation. Check User Friendly and 

your email to see what’s offered.    

  — Occasional free software and 

computer books, if you review 

them for User Friendly.  

    —   Annual Holiday Party             

   —      Social Interacting with oth-

ers who have like interests in 

computers and technology. 

       —  Special Interest Groups 

(SIGs) on various topics may be 

created by members. 

                                                 

MEMBERSHIP INFORMATION and BENEFITS of MEMBERSHIP 

 
Date: __________     LACS   New or Renewal Membership Application             

Check # ________                                         See note above for amount changes for 2023 
                   Please mail your dues and this form to: 

Los Angeles Computer Society, 11664 NATIONAL BLVD. #343, LOS ANGELES CA 90064-3802 
 

Please PRINT Clearly           [    ] New          [    ] Renewal 
 

[    ] New / Renewal with printed newsletter - $40.00       [    ] Associate - $12.00     [    ] Student - $18.00 
    
[    ] New / Renewal with electronic, no paper, newsletter - $30.00      [    ] Gift Membership - $20.00 
 
[    ] Contributor - $50.00    [    ] Supporter- $75.00     [    ] Benefactor - $100.00      [    ] Other 
        

Name:  First                                                                              Last                               
 

 

Name of Associate:  First                                                          Last 
(Same address as a primary member) 

___________________________________________________________________________________________________________ 

Address:  

________________________________________________________________________________________                                            

City, State, Zip + 4   
_________________________________________________________________________________________________ 

E-mail Address:                                                          E-mail of Associate                 
_________________________________________________________________________________________________                                                                   
Preferred Phone:                                                        Publish Contact Info in Roster  [    ] Yes     [    ] No   

                                                                                             

Did a member of LACS invite you to join? If so, who? If not, how did you hear about LACS? 

  

                                                                                                                                                                                    Revised Dec. 2020, ljc 

NOTE: See page 2 of this issue for an update on the new  

dues-paying system and for the amount due for each category 

of membership in 2023. 

mailto:PC@LACSPC.Groups.IO


Editor…..…………........... Leah Clark 

Indexer ……….….............Leah Clark 

Proofreaders …...........Irv Hershman,   

Jim McKnight, Stephanie Nordlinger, 

and Charlotte Semple        

User Friendly is published by the Los Angeles Computer Society.  

11664 NATIONAL BLVD, #343    LOS ANGELES  CA   90064-3802 

Voice-mail: 424-261-6251. Web site: https://www.lacspc.org 

GENERAL MEETINGS ARE ON ZOOM. 

Before each meeting, members and invited guests will receive an 

email with the URL link to the meeting. If you haven’t received it by 

the morning of the meeting, let Leah Clark know. When you click on 

the link, you will enter a waiting room. Then the host or a co-host will 

admit you to the meeting.  

Please try to arrive at least a few minutes before the meeting start- 

time so you don't interrupt the meeting and any technical problems 

can be solved. If you need to take a break during a meeting, do not 

click on Leave or End. If you do, the meeting will be interrupted for 

someone to re-admit you from the waiting room. You may turn off 

your video when you are gone. 

http://www.lacspc.org

